HYBRID GROUND SOURCE HEAT PUMP SYSTEM SIMULATION USING VISUAL MODELING TOOL FOR HVACSIM+

M.H. Khan, A. Varanasi, J.D. Spitler, D.E. Fisher, R.D. Delahoussaye
Oklahoma State University
Stillwater, OK, 74078, USA

ABSTRACT
This paper presents a simulation of a hybrid ground source heat pump system, performed using a new graphical user interface for HVACSIM+. Hybrid ground source heat pump systems incorporate both ground loop heat exchangers and supplemental heat rejecters, such as cooling towers, cooling ponds, or pavement heating systems. HVACSIM+ capabilities have recently been extended by the addition of ground loop heat exchanger models, water-to-water and water-to-air heat pump models, pavement heating system models, and heat rejection pond models. New component models are discussed and a hybrid ground source heat pump system with heated pavement as a supplemental cooler is simulated using the visual modeling tool.

First, though, an introduction to a new graphical user interface for HVACSIM+ is given. The user interface that originally came with the program could not be characterized as user-friendly. The new graphical interface allows users to develop system models by hooking components together. Provisions for controlling the simulation, setting the component parameters, editing the boundary file, and plotting the output are also included.

INTRODUCTION
HVACSIM+, which stands for ‘HVAC SIMulation PLUS other systems’, is a non-proprietary simulation package developed at the National Institute of Standards and Technology (NIST), Gaithersburg, Maryland, U.S.A. It is capable of modeling HVAC (heating, ventilation and air-conditioning) systems, HVAC controls, buildings, energy management systems, and other thermal systems. HVACSIM+ represents HVAC elements as individual components, e.g. fans, ducts, pumps, pipes, etc., which are connected to form complete systems. This allows the user to develop new models and introduce them in the package to simulate them in various configurations. This capability has been extended by the development of component models for ground loop heat exchangers (Yavuzturk and Spitler 1999), water-to-air heat pump (Yavuzturk 2000), heated pavement systems (Chiasson, et al. 2000a), shallow cooling ponds (Chiasson, et al. 2000b; Ramamoorthy, et al. 2001), and water-to-water heat pumps (Jin and Spitler 2002). The modular component based modeling environment, coupled with the available component models makes this a useful tool for design of hybrid ground source heat pump systems.

Although HVACSIM+ was developed two decades ago, problems exist that make the program difficult to use. Complexity of the user interface (HVACGEN) and difficulty in debugging the simulation are the two main problems as documented by Clark (1985). The user interface is a hierarchical menu-driven interface. If the user makes an error while configuring a system, the only way it can be corrected is either abort the process or supply arbitrary values to get to the next command prompt. Aborting the process discards all changes that have been made. This is time consuming and requires patience. The simulation work file, created using HVACGEN, and the model definition file created using SLIMCON are also difficult to understand, making debugging the simulation a near impossible task.

Nishi, et al. (1999) have discussed the shortcomings of the original HVACSIM+ interface in more detail. To overcome these shortcomings, they developed a Japanese-language-based graphical user interface. The English-language-based interface described in this paper is similar in some respects to that described by Nishi, et al. For further details, see Varanasi (2002).

DESIGN
The visual interface (Varanasi 2002) is developed using an event driven approach instead of the question and answer based logic HVACGEN uses. The visual interface provides a workspace for representing information about the system, a means to define the environment of such a system in terms of boundary values, simulate the system, and plot the simulation output.
The visual interface not only provides the functionality of HVACGEN, but also makes calls to SLIMCON and MODSIM (the kernel of HVACSIM+) thus eliminating the need for the user to use three different programs to build and run the simulation. Unlike HVACGEN, the visual interface doesn’t require the user to keep track of the variable indices. The visual interface uses icons and pictures to represent components, boundary variables and connections between them. Reusing an old simulation file is made easy because of the components being represented as icons and pictures. An online help system supports the tool.

IMPLEMENTATION
The core components of the application include graphical administration tools, the boundary file editor, the simulation manager, the plotting tool, and the residual reporting tool.

The graphical administration tools create components in the workspace, provide information on the component icons, perform various editing operations like cut, copy and paste, and remove icons from the workspace. These tools also handle operations like dragging components around the workspace, to provide a visually well-organized system configuration.

The boundary file editor mimic a traditional spreadsheet organizer providing editing operations and having a matrix of rows and columns, where columns represent boundary conditions and rows represent data values for all the boundary conditions at specific times.

The simulation manager analyzes the workspace for basic errors and sets up an environment for calling SLIMCON and MODSIM. The program manages the execution of SLIMCON and MODSIM in the DOS shell and tries to interpret the errors generated. Error handling is performed to interpret any errors generated. The simulation manager also modifies the output files to add additional information, like variable descriptions assigned by the user, to clearly associate data with simulation variables. There is also no need for the user to open the output files and study them manually since the interface can plot the graphs immediately after the simulation ends.

The plotting tool allows the user to select reported variables and the tool reads the variable data and the associated time values from the output file. The user has the ability to plot multiple reported variables in one graph. Routines are provided in the tool to adjust the scale and print the plots.

During a simulation, HVACSIM+ may sometimes conclude that it has converged without reaching a reasonable value of the residual. It is sometimes necessary to examine the residuals to determine whether or not the equation solutions have truly converged to acceptable values. The interface facilitates plotting residuals both while a simulation is running as well as from a previously created Diagnostic information file.

GRAPHICAL USER INTERFACE
The Graphical user interface (GUI) from here on referred to as the workspace, consists of scrollable screen where a system can be specified by inserting components, connecting input and output variables, specifying and connecting boundary conditions as input variables. Parameter values and initial values for components may be set in dialog boxes brought up by double-clicking on the component icons.

Figure 1 shows the available menu and toolbar options. Operations such as opening, saving and printing a workspace can be performed using the File menu. The Edit menu options provide facilities to perform operations such as cut, copy, paste, delete and find. The Settings menu allows specification of units, boundary conditions and connections selected by the user. For large and complicated simulations, involving many components, the Hide All Connections and Show All Connections menu options can be used to hide or show the connections in the workspace. The Settings menu can be used to set the simulation requirements, the locations of MODSIM and SLIMCON and the serial number for the workspace. The Boundary File Editor can be accessed through the Boundary-Conditions menu. A simulation can be initiated and executed using the Simulation menu. The simulation output can be plotted using the options in the Reports menu.

The Types component library and the Boundary conditions library shown in Figure 1 can be used to insert HVACSIM+ models and boundary conditions in the workspace, respectively. These components are visually represented as icons in the workspace.
Figure 2 shows the various components and their icon descriptions using an example.

The user can view or change parameter values and initial values of components in the workspace. Properties that can be set include parameter values, and Figure 3 shows a dialog box where the parameter values and initial values of an example unit have been set.

Two kinds of boundary conditions can be inserted in the workspace -- constant boundary conditions and time-dependent boundary conditions. The interface provides an efficient way of attaching time-dependent boundary variables to columns in the boundary file.

EXAMPLE HYBRID GROUND SOURCE HEAT PUMP SYSTEM SIMULATION

Ground source heat pump (GSHP) systems have become increasingly popular as an efficient and environmentally friendly means of providing heating and cooling for commercial as well as residential buildings. Compared to air source heat pumps, relatively high efficiencies may be obtained because of the naturally moderate temperatures of the earth as a source/sink, and the low temperature differences between the refrigerant and heat transfer fluid.

Particularly in warmer climates, commercial buildings are usually cooling dominated. The cooling dominance results in an imbalance between heat extracted from the ground and heat rejected to the ground. Over time, this imbalance raises the loop temperatures and reduces the heat pump COP. To rectify this problem either the ground loop heat exchanger size can be increased and/or a supplemental heat rejecter such as pavement heating system, cooling tower and shallow cooling pond can be added. Increasing the size of the ground loop heat exchanger (GLHE) increases the capital cost and may exceed space constraints. The use of a supplemental heat rejecter may allow the GLHE size to be kept relatively small, and also allow for lower fluid temperatures, and, hence, higher heat pump COP. GSHP systems which use a supplemental heat rejecter are known as hybrid ground source heat pump (HGSHP) systems.

Design of HGSHP systems is complicated by the large number of degrees-of-freedom. The GLHE size, supplemental heat rejecter size, equipment capacity, control strategy, etc. all affect the design. The continuously changing environmental conditions and building loads combined with the very large time constant of the GLHE make it very difficult to do any near-optimal design without the aid of system simulation. Two previous studies that utilized TRNSYS investigated performance of HGSHP systems with cooling towers (Yavuzturk and Spitler 2000) and cooling ponds (Ramamoorthy, et al. 2001).

In this paper, we look at performance of an HGSHP system that utilizes a pavement heating system as a supplemental heat rejecter.

1. System Description

The example building has an area of is 1,320m² and is located in Tulsa, OK. The hourly annual building heating loads (+) and cooling loads (-), shown in Figure 4, were calculated using BLAST (1986). The following approach was taken:

i) Eight different thermal zones were identified in the building. For each zone, a single zone draw through fan system is specified. The total coil loads obtained are assumed to be equal to the loads to be met with the heat pumps.

ii) The occupancy is 1 person per 9.3 m² with a heat gain of 131.9 W, 70% of which is radiant, on an office occupancy schedule.

iii) Equipment heat gains are 12.2 W/ m², lighting heat gains are 12.2 W/ m², both on an office schedule.
Figure 4: Annual hourly building loads for the example building

Figure 5 shows a schematic of the hybrid GSHP system. The system uses a pavement heating system (Chiasson, et al. 2000a) as a supplemental heat rejecter. The pavement heating system would consist of hydronic tubing embedded in the concrete parking lot or sidewalk. The only additional capital cost is the cost of the tubing, its installation, an additional circulating pump, and additional controls.

An equation fit model, based on manufacturer’s catalog data was used for the heat pump, a Trane WPVD 150. The model determines exiting fluid temperature and power consumption based on the entering fluid temperature, cooling or heating load, and the fluid flow rate. A correction factor provided by the manufacturer for antifreeze was taking into account in calculating the coefficients for the heat pump.

The ground loop heat exchanger (GLHE) model is that described by Yavuzturk and Spitler (1999), which is an extension of the long-time step temperature response factor model of Eskilson (1987). Typical values for ground conductivity, borehole diameters, pipe diameters, grout thermal conductivity, etc. were taken from Yavuzturk and Spitler (2000). The number of boreholes and length of the ground loop heat exchanger for the base case was determined so that the maximum entering fluid temperature would not exceed 35ºC.

The circulating pump was sized to maintain a flow of approximately 0.22 kg/s in each borehole. This flow rate was chosen to maintain turbulent flow over the expected range of temperatures. However, the mass flow rate was determined at each time step, as discussed in the next section.

For cases where a supplemental heat rejecter was used, the cross-linked polyethylene hydronic tubing was embedded in a 200 mm thick concrete slab, at a depth of 76 mm, spaced 152 mm apart. The number of circuits and length per circuit vary.

For the hybrid system, the size of the ground loop heat exchanger, the size of the supplemental heat rejecter, and the system operating strategy are interdependent. Future research may be aimed at optimal sizing strategies. For the present study, the GLHE has been reduced in size to be approximately correct if the annual heat extraction remains the same, but the annual heat rejection is reduced to balance the heat extraction.

The decision to turn on the supplemental heat rejecter is based on the differential control strategy developed and shown to perform well for HGSHP systems with cooling towers by Yavuzturk (1999). The controller turns on the secondary loop when the difference between the heat pump exiting fluid temperature and pavement exiting fluid temperature exceeds 5ºC, and is turned off when the difference falls below 0ºC.

2. Simulation

Three cases were simulated to predict the system performance over a period of 10 years and to evaluate the impact of using different size pavement heating systems as a supplemental heat rejecter. Each case is discussed below, along with the associated simulation issues.

Case 1 (base case): The base case is a GSHP system with no supplemental heat rejecter. Based on the 35ºC maximum design EFT, a square borehole field with 16 boreholes, each 73.2 m deep and spaced 3.7 m apart was selected. The heat transfer fluid was water. A circulating pump was selected that would provide a design flow rate of 3.52 kg/s. The system consists of a heat pump, a GLHE, pipe and fitting models and a circulating pump.

An important aspect of the system simulation is choosing the method for determining the fluid mass flow rate. The simplest approach would be to simply set the flow rate, and assume a fixed value. However,
the flow rate will vary over the year as fluid temperatures, densities and viscosities change. This may be relatively unimportant with pure water, but it was thought that it may be significant when a water/propylene glycol mixture is used, as in cases 2-3. Issues related to solving mass flow rates and pressure differences simultaneously with temperatures and energy flows in duct/pipe networks have been discussed at some length by Chen, et al. (1999). They developed a separate flow rate and pressure calculation module with its own solution procedure, which allowed them to keep the flow rate solution inside the same superblock as the rest of the system. We have used a simpler, but less powerful procedure. First, component models for pipes and fittings were developed that took mass flow rates as input variables and gave pressure drops as output variables were developed. Second, a dimensionless model of a centrifugal circulation pump was developed that gives mass flow rate as an output with pressure rise as an input. Using a simple pressure drop summing component and a mass flow dividing component, the flow network was configured as a separate superblock.

In the visual modeling tool, the entire system is configured as shown in Figure 6. The flow network is comprised of the components on the right side of the screen. The flow network represents some balance between lumping everything together and showing every component. The heat pump and fittings on two different size pipes are represented as three different fittings. The U-tubes are represented by a single pipe (with the total mass flow rate divided by sixteen in the mass flow dividing component); the supply and return pipes are each represented separately.

**Case 2:** The system was simulated with a reduced GLHE size (a square 9 borehole field with the same spacing and depth as Case 1) and a pavement heating system. The pavement fluid circuit is turned on by switching the pump 2 (shown in figure 5) whenever the difference between the heat pump exiting fluid temperature and the outlet fluid temperature of the slab hit an upper setpoint of 5°C and is turned off when this difference hits a lower setpoint of 0°C. The heat transfer fluid was water with 30% propylene glycol as antifreeze, necessary to prevent the water in the slab from freezing if the system is turned off. The system was setup using the visual modeling tool as shown in Figure 7.
Case 3: The size of the pavement was increased to see the effect of providing more supplemental cooling on the heat pump power consumption. The pavement area was increased to 48m² with 26 flow circuits and each circuit having 3 pipe passes.

Table 1
Summary of design parameters for each simulation case

<table>
<thead>
<tr>
<th>Case</th>
<th>No of Boreholes</th>
<th>Borehole Depth m</th>
<th>Pavement Area M²</th>
<th>Flow Circuits /pipe length per circuit(m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case1</td>
<td>16 (4x4)</td>
<td>73.2</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Case2</td>
<td>9 (3x3)</td>
<td>73.2</td>
<td>36</td>
<td>19 / 18</td>
</tr>
<tr>
<td>Case3</td>
<td>9 (3x3)</td>
<td>73.2</td>
<td>48</td>
<td>26 / 24</td>
</tr>
</tbody>
</table>

Results

Table 2 summarizes the power consumption of the heat pump and the circulating pump for each case. Since the heat pump power varies somewhat from year to year, both the first year and tenth power consumptions are given. Since the circulating pump power varies negligibly, only the average value is given.

Table 2
Heat pump and circulating pump power consumption.

<table>
<thead>
<tr>
<th>Case</th>
<th>Annual Heat pump power consumption (kWh)</th>
<th>Annual average circulating pump power consumption (kWh)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1st year</td>
<td>10th year</td>
</tr>
<tr>
<td>Case 1</td>
<td>13,727</td>
<td>14,104</td>
</tr>
<tr>
<td>Case 2</td>
<td>15,129</td>
<td>15,627</td>
</tr>
<tr>
<td>Case 3</td>
<td>14,970</td>
<td>15,243</td>
</tr>
</tbody>
</table>

Case 1 (base case): Figure 8 shows the variation of heat pump EFT over the ten-year simulation period. The maximum EFT for the first year is 31°C and rises to 34°C for the 10th year.
Case 2: The EFT for the heat pump is shown in Figure 9. The EFT are somewhat higher than for Case 1, indicating the supplemental heat rejecter does not fully compensate for the reduction in GLHE size. However, the total power costs are somewhat lower than for Case 1 – because the smaller GLHE has a smaller total flow rate, the pumping costs are significantly reduced. On the other hand, the heat pump performance is also reduced by the lower flow rate.

Case 3: An increase of a third in the pavement heating system leads to fairly slight decreases in the EFT and about a 1% decrease in heat pump power consumption.

A complete life cycle cost analysis is beyond the scope of the paper. However, it might be noted that using the same economic assumptions as Yavuzturk and Spitler (2000) the reduction in first cost by eliminating 7 boreholes is approximately $10,000. The incremental cost of a 36 m² pavement heat exchanger is expected to be approximately $2,000-$3,000. (This does not include the cost of the pavement, just the incremental cost for adding hydronic tubing, controls, and a second circulating pump.) In addition, a small annual savings, about $150 in electricity is also obtained.

Furthermore, the HGSHP system also results in some snow-melting. The model is capable of predicting snow-melting, although it cannot account for snow plowing or shoveling. If no other snow removal is performed, an unheated concrete slab will be snow or ice-covered for about 175 hours during a typical Tulsa year. When using the slab for heat rejection, this is reduced to about 115 hours.

One other aspect of the simulation may also be commented upon. The system was modeled with variable flow, where the variations in flow were only due to changes in viscosity. Even with a mixture of water and 30% propylene glycol, which changes viscosity by a factor of three in the range of fluid temperatures encountered in the system, the change in flow rate is fairly small. The flow only varied within a 3% band over the course of the simulation. This is partly dependent on the design operating point of the pump; flow rates may vary more in other systems.

When the simulation was simplified by assuming a fixed mass flow rate, the heat pump entering fluid temperatures varied negligibly, and, for cases 2 and 3, the predicted heat pump power varied less than 1.5%. So, the variable flow rate simulation may be unnecessarily complex.

CONCLUSIONS
A graphical user interface has been developed for HVACSIM+. This significantly reduces user effort in
developing system simulations. The interface was used to develop a simulation of both standard and hybrid ground source heat pump systems.

The hybrid ground source heat pump system used a pavement heating system as a supplemental heat rejecter. Compared to the standard GSHP system, the HGSHP system has significantly lower first costs and slightly lower operating costs. Some snow-melting is also obtained as a side benefit.

The HGSHP design problem offers ample opportunity for design optimization, although little work has been done to date. Possible independent variables include ground loop heat exchanger size, pavement heat rejecter size, system flow rates, system operation and control strategies, etc. This tool could be a useful aid in optimization – certainly the simulation might be incorporated into a global optimization procedure.

REFERENCES


